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Microsoft Word 2013 is the latest release of the world’s number 
one word processing program. I know what you’re thinking, 
“ugh, another product version I have to relearn.” Having mixed 
feelings about any software program that offers new and 
improved features is not uncommon. On one hand, seeing what 
sort of changes Microsoft has made to the program is exciting, 
but on the other hand, learning it all over again might mean 
more time and effort on your part. Don’t worry—whether you’re 
a new user or a seasoned pro, you can get up and running fast 
with this latest version of Word with a little help from the book 
you’re holding.

I’ll explain everything. In fact, it will seem like I’m practically 
there beside you going over each feature. You’ll be particularly 
happy to know we take regular snack breaks along the way. I 
am a big proponent of snack breaks, as long as you wipe up 
your sticky keyboard. As your own personal computer tutor, I’ll 
show you how to utilize all the major features available in Word 
to help tackle different tasks you might experience at home, at 
work, or on the go. Whether you want to type up a company 
memo or build a grade “A” research paper, in this book you 
learn where to find what you need and make it work for you. We 
can all certainly pontificate ‘til the cows come home about what 
a wonderful and powerful program Word is, but you just want to 
get your work done, so why not have a little fun along the way?

INTRODUCTION
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Who This Book Is For
Obviously, the first thing to figure out is whether this book is for you or not. 
You’re in luck—I wrote it just for you. How can you be so sure? This book is for 
you if…

 • You need to learn how to use Word’s new tools and features fast without 
wading through a lot of exposition.

 • You want easy-to-understand examples and instructions to help you see 
exactly what’s going on with your own computer screen.

 • You’re curious to know how to start using all the cloud storage and cloud 
computing features now available to all Microsoft Word users and interested 
others.

 • You’re brand-spanking new to Word and not as confident as you would like to 
be using a word processing program.

 • You’re a long-time Word user and you need to find out what changed 
between the previous version of Word and this latest version.

 • You want to learn all about Word without being bored to tears and/or 
potentially missing any snack breaks.

How This Book Is Organized
Microsoft Word 2013 Absolute Beginner’s Guide is divided into six parts.

Part I, “Word Basics,” introduces all the fundamental information you need 
to find your way around the new program window and its tools, plus set up 
your Microsoft account. That’s right, you use an account now to access all that 
Microsoft has to offer online, all from within the Word program window.

Part II, “Building Simple Documents,” shows you how to start creating documents, 
saving them to your cloud storage or on your computer, building documents out 
of templates, and using the various methods for adding text.

Part III, “Making Documents Look Impressive,” introduces you to all the 
formatting tools you can apply to your documents to make them look polished 
and professional. Learn how to assign attributes to text, paragraphs, and entire 
pages, including changing fonts and sizes, controlling text positioning, and 
applying styles and themes.

Part IV, “Adding Visual Elements with Tables, Charts, and Graphics,” shows 
you how to start inserting all kinds of illustrative elements into your documents, 



INTRODUCTION   3

including building tables, diagrams, and adding pictures. You also learn how to 
draw your own artwork using shapes and snazzy text art.

Part V, “Using Specialized Word Tools,” covers all the nifty features for working 
with longer types of documents, such as footnotes and bookmarks. This part of 
the book also demonstrates how to utilize proofing tools and how to print out 
your pages when everything’s ready to commit to paper.

Wait—that’s not all! There’s a whole other part of the book waiting for you online! 
That’s right, it’s a bonus section just because readers like you deserve more (plus, 
there’s so much stuff to tell you about Word, I couldn’t fit it all into this book). 
Visit http://www.quepublishing.com/title/9780789750907 to learn how to share 
your Word documents with others, including how to collaborate with Word’s 
tracking and revision tools, how to share your Word content over the Internet as 
well as bring Internet content into your documents. Yes, it’s the book that keeps 
on giving!

Conventions Used in This Book
Microsoft Word 2013 Absolute Beginner’s Guide uses a number of conventions to 
provide you with special information. These include the following elements:

TIP Tips offer suggestions for making things easier or provide 
alternative ways to perform a particular task.

NOTE Notes provide additional, more detailed information 
about a specific Word feature.

CAUTION Cautions warn you about potential problems that 
might occur and offer advice on how to avoid these problems.

So in summation, Microsoft Word 2013 Absolute Beginner’s Guide is beautifully 
tailored to help you master this latest version of Word with minimal tedious-
ness and maximum enjoyment. Go grab your favorite snack and let’s not waste a 
moment more—you have word processing stuff to learn.

http://www.quepublishing.com/title/9780789750907
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Bonus coverage available FREE on the World 
Wide Web!

 • Share Word content online and integrate web content into your documents 

 • Access and edit your documents from anywhere through SkyDrive

Bonus chapters may be found on the Que product page 
http://www.quepublishing.com/title/9780789750907 within the “Downloads” tab.

http://www.quepublishing.com/title/9780789750907


This page intentionally left blank 



INSERTING PICTURES AND 
VIDEOS
Time to kick your graphics knowledge up a notch and start illustrating 

your documents with visuals that are a bit more complex in nature than 

the shapes and WordArt images covered in Chapter 14, “Adding Simple 

Graphic Elements.” I’m talking about digital pictures. Although they offer a 

great deal more in pixels, they aren’t any more difficult to   add than simple 

graphic elements, such as shapes. However, the impact they bring to your 

documents is considerable. Pictures have the power to provoke, inspire, 

explain, and communicate in a glance. In this chapter, you learn how to 

tap into the vast collections of images available on the Microsoft Office 

website, as well as insert your own photographic images stored on your 

computer or memory device.

Pictures fall under the broad umbrella  of graphic elements you can add to 

spruce up and complement your text. The term picture loosely covers any 

sort of detailed image, whether it’s computer-generated artwork from a

I N  T H I S  C H A P T E R

15
• Learn what makes picture file formats so fascinating.
• See how easy it is to look for pictures online 
• Grab pictures from your SkyDrive account and insert 

them into your documents just because you can.
• Insert your own picture content from your camera or 

other stored image files.
• Take a capture of your computer screen and insert it 

into your document.
• Embed a video into a document and play it like a 

pro.
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drawing program or a photograph taken with a digital camera or scanned in using 
a scanner device. Whether you like to call them pictures, illustrations, images, or 
artwork, we’re still talking about the same type of visuals you can put to use in 
your own word-processing tasks.

Understanding Picture File Types
Before you dive head first into inserting pictures, I thought I would give you the 
scoop about picture file   types. At first glance, this might not be anything you’re 
interested in, but knowing a few things about file formats for pictures might help 
you out when you’re searching for artwork to insert into your documents. The 
devices and programs used to make pictures determine what sort of file format is 
assigned to the picture file. Just as Microsoft Word makes document files (which 
utilize  the .DOCX file extension), programs and devices that create pictures make 
different kinds of picture file formats. For example, my digital camera typically 
spits out JPEG files when I import them into  a photo viewer program. Yours might 
assign another format, such  as TIFF. A piece of clip art you download from the 
Office website might use the WMF format. Knowing the file type can help you as 
you organize and search for picture files on your computer and on the Web.

Figure 15.1 shows examples of four different picture file types. Your naked eye 
might not distinguish a great deal of difference between them, but behind the 
scenes in the coding, things become very different.

FIGURE 15.1

Picture files use different file formats. You had better know this for the quiz later.
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Obviously, different graphic file types are used with different scenarios. For 
example, graphics for Web use don’t   require the same quality settings as those 
used in professional printing. With everyone sharing picture files these days, 
though, either directly or over the Internet, file size and quality is an issue 
regardless of the scenario. Picture files are notoriously large in size because of all 
the colors and details needed to make them. Because of this, data compression 
techniques are employed to help keep picture file sizes down. Lossy compression 
and   lossless compression are two such methods. Lossy compression reduces the 
file size by eliminating certain data, such as redundant information; but when 
uncompressed, some of the original data is gone. With lossless compression, 
everything in the file can be recovered when the file is uncompressed. Image 
file formats, like those described in the following list, apply these types of data 
compression methods to reduce the overall file size.

The most common picture formats you’ll encounter today are

 • JPEG or JPG Stands for  Joint Photographics Expert Group. JPG is commonly 
used on photos and  similar types of illustration files. Its flexible compres-
sion levels let you control the file size. JPG is a good choice when you want 
a smaller file size for an image, but that means the quality is lower due to its 
lossy compression method. However, the quality loss might not be noticeable.

 • TIFF or TIF Stands for Tagged Image File Format. TIFF is great for high-
color, high-depth digital  images, and its lossless compression format retains 
image quality no matter how many times you open and resave the file. TIF is 
the   highest quality for commercial work.

 • PNG Stands for Portable Network Graphics. PNG is a bitmap file format 
designed  specifically for use with web pages. It was originally designed to 
replace the GIF format to save color information more efficiently. Although not 
as popular as JPEG and TIFF, it’s a good choice for lossless quality images.

 • GIF Stands for Graphics Interchange Format. GIF  is an older file format com-
monly used with simple graphics, such as logos, shapes, and icons. It also 
supports animation. It’s a bit limiting for today’s digital technology (it only 
supports 8-bit, 256 color at the maximum), but it still has its place on the Web 
for simple graphics.

 • BMP Stands for Windows  Bitmap. This file format is commonly used with 
Windows graphics. Also   called raster or paint format, it’s not compressed, 
which results in a   larger file size. BMP files aren’t very popular as web graphics.

 • RAW This is uncompressed digital image data straight from your camera. 
It’s not been fiddled with or compressed in any way. You must convert RAW 
files to another file  format in order to open them in a photo-viewing program. 
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If you hand someone a RAW file, chances are they can’t read it; it has to be 
converted first. With Windows 7 and later, the Camera Codec Pack helps with 
reading RAW file types.

 • DNG Stands for Digital Negative. DNG is a new  open standard RAW format 
developed by Adobe, and just about every digital photo program can read 
DNG file types.

Hey, don’t think I didn’t notice your eyes glazing over after reading about all 
those file types. Just remember to flip back to the list if you ever need to identify 
one as you encounter   different graphic files on your computer journey.

NOTE A picture’s file format can tell you a lot about the 
compression, which in turn can tell you about the picture’s 
quality. Other file formats can tell you about the program 
from which it originates. You will run into other formats, such 
as Windows Metafile Format (WMF) for things such as clip art 
illustrations, but don’t let the formats throw you off. Lots of 
programs, like Adobe Illustrator, save artwork in a native file 
format (AI for Adobe Illustrator), so you’ll run across all kinds of 
different formats as   you work with different graphic elements.

Inserting Images from the Internet
In the prehistoric days of early computing, digital artwork was quite rudimentary, 
jaggedy-edged and limited in color scope. It often looked like a caveman drew 
it rather than a highly    qualified computer programmer. As time progressed, 
predrawn clip art began  to proliferate among software manufacturers as clip 
art collections, allowing users to easily illustrate their files with cartoony-like 
graphics. The collections themselves used to install with software programs, 
such as Microsoft Word, and included a small variety of themes related to 
business, desktop publishing, and computer technologies. Eventually, full-blown 
photographic images—also called stock photography—made  their way into clip 
art collections, too.

NOTE Clip art got its  name from the practice of clipping 
the artwork from existing printed art. Long before computers, 
printing people clipped artwork from other printed material 
and pasted it onto new publications. Now most publications are 
produced through desktop publishing software.

Today, most of the image collections offered with software programs are available 
online. Rather than clog up your computer’s hard drive with lots of images you 
might not ever use, you can access pictures on the Web instead and find just the 
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right ones you want. With an Internet connection, you can peruse vast libraries of 
pictures, from drawings and illustrations to photographs and video clips.

You need an online connection and a Microsoft account to tap into the Office.
com site and search for artwork. The Insert Pictures feature,  shown in Figure 
15.2, lets you search for pictures    in the following sources:

 • Office.com Search through Microsoft’s  own collection of royalty-free pictures.

 • Bing Image Search Use this option to search for pictures  on the Web using 
Microsoft’s Bing search engine.

 • SkyDrive If you store pictures on your cloud account, you can use this 
option to  look for picture files among your SkyDrive content.

That’s not all: If you use a Flickr photo sharing  account, you can add it to the mix 
and search for digital pictures    from it as well.

FIGURE 15.2

The new Insert Pictures box lets you search for online pictures from several sources.

Thumbnails are miniatures   of images. Rather than take up a lot of space with full-
size images, most photo displays used in galleries, photo viewers, and search 
engines show smaller versions of the images. The term thumbnail also applies 
to files you view using Windows Explorer. For example, you can choose to view 
folder contents as thumbnails. This sort of gives you a glance at what the files 
contain without the    inconvenience of a full-on screen-hogging view.

NOTE Pictures offered through the Office.com site are 
royalty-free, which means you can use them for free. That’s 
not always the case with other web content. Be careful about 
randomly copying artwork from other sources or you might be in 
copyright violation.
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TIP You can always use the good old Copy and Paste 
commands to copy pictures into your documents    from 
other sources.

Using Pictures from Office.com
To insert a picture from Microsoft’s    online collection, follow these steps:

 1. Click the Insert tab.

 2. Click Online Pictures to open the Insert Pictures tool (see Figure 15.2).

 3. Click in the Office.com Clip Art search field and type in a keyword or words 
for the type of picture you’re looking for.

 4. Press Enter or click the Search icon.

 5. A search results page lists any matches, similar to Figure 15.3. Use the scrollbar 
to look through the thumbnails.

Click the picture you want

Click here when you’re ready to download the image

FIGURE 15.3

Look through the search results to find the picture you want to use.

 6. When you find one you want, click it. If you find more than one, press and hold 
the Ctrl key while clicking each image.

 7. To download the picture, click Insert.



CHAPTER 15  INSERTING PICTURES AND VIDEOS 243

When the download is complete, Word inserts the picture into your document, 
much like what you see in Figure 15.4, and displays a new Format tab for working 
with    the image. You might need to resize the picture right away to make it fit. 
More often than not, you’ll find yourself having to do this with any artwork you 
bring into Word. Drag a picture’s corner selection handle to resize the image. To 
move the picture around in the document, click and drag it.

Format tab

Selection handles

FIGURE 15.4

Word downloads the picture and inserts it for you. In this example, I inserted a clip art 
illustration.

If your initial search doesn’t result in any good matches on Office.com, try typing 
in another keyword or phrase in the Search box. Finding the right picture for an 
occasion might take a few tries. If you give up on searching, click the Back to 
Sites link in the upper-left corner to return to the main Insert Pictures screen and 
try    another source.

TIP In Chapter 16, “Fine-Tuning Your Graphics,” you can learn 
how to apply some formatting techniques to your pictures, such 
as how to add shadows, 3-D effects, borders, and more.
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LEISURELY PICTURE SHOPPING
The new Insert Pictures tool forces you to type in keywords and then perform a 
search to look for images on the Office.com website. You might prefer a more 
leisurely approach to looking for just the right picture. You can use your browser 
window to navigate to the Microsoft Office website and peruse to your heart’s 
content. Open the main page (www.office.com) and click the Images link at the 
top. This takes you to the Clip art, photos, and animations page. You can scroll 
around and click different categories and look through the selections, and if you see 
something you want, you can download it or copy it. Just hover the mouse pointer 
over the picture and click either Copy or Download.

If you click Copy, you can return to your Word document and activate the Paste 
command to immediately add the picture to your document.

If you click Download, you can save the picture file to a designated folder or drive 
on your computer. By default, downloaded pictures are automatically saved to the 
Windows Downloads folder, unless you specify somewhere else. Here’s a tip: To 
make the picture easier to find later, you might want to    give it a name you’ll recog-
nize. The Office.com pictures typically have cryptic names that never really signify 
what the image is.

Searching for Pictures Using Bing
Now let’s try searching for pictures using the Bing Image Search feature. As you 
might or might not    know, the Bing search engine is part of Microsoft’s world 
domination plan, so all the Microsoft Office programs point you toward Bing any 
time you want to conduct a web search from within the programs.

To search the Web for pictures using Bing, follow these steps:

 1. Click the Insert tab.

 2. Click Online Pictures.

 3. Click in the Bing Image Search field and type in a keyword or words for the 
type of picture you’re looking for, as shown in Figure 15.5.

 4. Press Enter or click the Search icon.

 5. A search results page lists any matches, similar to what you see in Figure 15.6. 
Use the scrollbar to look through the thumbnails. Notice this time there’s a big 
warning in the box about copyright material. Unlike the Office.com site, the 
items you search for using Bing are not necessarily royalty-free.

http://www.office.com
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Type your search keyword(s) here

FIGURE 15.5

This time, let’s search with Bing.

FIGURE 15.6

The results are images gathered from all over the Web that match your search criteria.

 6. When you find a picture, click it to view its details, as well as a link to its web 
address    you can use to learn more about the image.

 7. Click Insert.
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NOTE You can click a picture in your Bing search results 
to view a link to the source’s website. Look in the bottom-left 
corner to view the link. Click it and you can learn more about 
where the picture comes from and how to contact the owner to 
ask for permission to use it. It never hurts to contact the source    
and ask. If you notice you are not able to copy, download, or 
use the PrintScreen capture to nab an image, then it’s probably 
not supposed to be used by anyone else; stay away from 
protected images.

Searching for Pictures on SkyDrive
SkyDrive is Microsoft’s file-hosting service, and if you store your photos on your 
cloud account with    Microsoft, you can insert pictures from SkyDrive and place 
them in your documents.

To search your SkyDrive account for pictures, follow these steps:

 1. Click the Insert tab.

 2. Click Online Pictures.

 3. Click the Browse link under the SkyDrive option (see Figure 15.7).

 4. Open the folder containing your pictures and click the picture you want to 
insert (see Figure 15.8).

 5. Click Insert.

As soon as you click the Insert button, Word downloads the picture and inserts it 
into your document. You will probably need to resize the picture to fit; just drag a 
corner    selection handle, pointed out in Figure 15.9, to resize the image.
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FIGURE 15.7

Now let’s try searching your SkyDrive storage for pictures.

Click here to search your SkyDrive folders

FIGURE 15.8

I’m looking for a frog picture, and I think this is the one.
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FIGURE 15.9

It’s a tree frog resting on a    zinnia flower leaf, if you must know.

NOTE Are you new to SkyDrive? If so, you might be 
wondering how to store pictures on the cloud. It’s easy. First use 
your favorite web browser to navigate to www.skydrive.com 
and log on to your account. Next, look for an Upload link at the 
top of the page and follow the onscreen directions to upload 
pictures from your computer to the cloud storage site. If you’ve 
activated the Windows SkyDrive folder on your computer (look 
for it listed under Favorites in the Explorer window), you can also 
drag files to it to store them in the cloud without having to open 
the browser.

If you have a Flickr account, click the Flickr icon at the bottom of the Insert 
Pictures window and follow the    instructions to connect your account. If you don’t 
have a Flickr account, you can use the link to make one.

Inserting Your Own Pictures
You can access any image stored on your computer and insert it into a Word file. 
If you have a digital camera, you   might end up being the only illustrator your 
documents need. Digital cameras make adding your own visual content easier 

You can resize a picture using a selection handle

http://www.skydrive.com
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than ever. You can transfer files from the camera to your computer’s hard drive, 
or you can store photos on a flash drive or memory card and access them from 
your PC.

To insert a picture stored on your computer or other plug-in devices, follow 
these steps:

 1. Click the Insert tab.

 2. Click Pictures to open the Insert Picture dialog box (see Figure 15.10).

 3. Navigate to the folder or drive containing the picture you want to use and click 
the filename.

 4. Click Insert.

FIGURE 15.10

Use the Insert Picture dialog box to add pictures found on your computer.

After you add a picture, you can easily resize it by dragging its selection handles. 
You can also drag it   around to move it to a new location in the document. Look 
for the familiar Layout Options icon that appears in the upper-right corner of a 
selected picture; you can use it to control text flow around a picture.

As soon as you insert a picture, the Picture Tools Format tab is added to the 
Ribbon. This specialized tab displays tools you can use to edit your picture. You 
can learn more about ways to modify an image in the next chapter.
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NOTE You can store data, including pictures, on a wide 
variety of devices these days. Most digital cameras utilize 
memory cards, for example, that pop in and out of the camera 
as well as any card reader slots on a computer. Flash drives (also 
called thumb drives, stick drives, or key drives) are compact 
    stick-like storage you can use by plugging into a USB port. Flash 
drives are incredibly handy for storing files and transferring 
them between computers and other devices. Writable CDs and 
DVDs let you save files using an optical disk drive. Lastly, if you 
have an external hard drive, you  can plug it into your computer 
and store picture files. When you’re inserting pictures with the 
Insert Picture dialog box, you can navigate to any of these types 
of storage devices to retrieve a picture file. Just specify the 
appropriate drive listed in the left pane to view the contents.

TIP To remove any picture or video clip you insert, select it 
and press Delete.

Capturing Screenshots
You can use Word’s Screenshot tool to add a snapshot of any open   window on 
your desktop and immediately   insert it into a document. You can also use it to 
take a clipping of a portion of anything open on the desktop, such as a sticky 
note or a game screen.

For example, maybe you’re assembling a department budget in Excel and you want 
to grab a picture of your progress to include in a memo document you’re creating 
in Word. You can capture the Excel window as a screenshot and tuck it away in 
your Word document as an illustration of how things are going. Or how about this: 
You’re working on a report about a newly discovered iguana and want to grab 
a picture of the news story from your web browser window so you can read and 
reference it later. You can do this with the Screenshot tool. Pretty nifty, eh?

The feature keeps track of the current windows you have open, even though 
you’re busy working in Word. It also keeps track of multiple Word documents you 
have open, so you can use it to snap screenshots from one document to insert 
into another. The key to using the feature is to make sure the window you want to 
capture is not minimized on the Windows Taskbar, but open onscreen.

Ready to give this a whirl? Start by opening a program window or Windows 
feature you want to capture. Remember, it can be any kind of window—a game, 
a sticky note, the Windows calculator, a photo viewer, web browser, and so on. 
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Display the Word window and click the Insert tab. Now click the Screenshot 
drop-down arrow, as shown   in Figure 15.11, and click the window you want to 
insert. Boom, that was fast—the captured window is immediately inserted! Figure 
15.12 shows an example of a screenshot.

FIGURE 15.11

Use the Screenshot tool to add a screenshot of any open window or Windows feature.

FIGURE 15.12

The screenshot is immediately added to your   document, complete with a border.
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TIP Capture the wrong screen? Just click the Undo button on 
the Quick Access toolbar or press Ctrl+Z to remove the pasted 
screenshot or clipping right away and try again with the right one.

Now let’s try out a screen clipping. Again, start by having the window open that 
you want to clip from, such as a photo album, web page, or game. Next, click the 
Insert tab and click the Screenshot drop-down arrow. Click Screen Clipping (see 
Figure 15.11 to locate this command). The first time you use the screen clipping 
tool, it’s a little  odd because your screen turns a foggy white color and the mouse 
pointer turns into a crosshair icon, like you see in Figure 15.13, but that’s just your 
cue to drag across the clipping you want to capture. So, drag across the part of 
the screen you want to clip, as shown in Figure 15.14. The part you’re clipping 
becomes clear as you drag. As soon as you release the mouse button, the area 
you dragged over is inserted into your Word document, much   like what you see 
in Figure 15.15. Don’t wait too long to drag over the clipping area or the function 
times out and you have to start all over again.

Move the crosshair icon to the upper-left corner where you want to clip

FIGURE 15.13

The first phase of the screen clip turns your screen foggy.
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FIGURE 15.14

The second part of the process is to drag over the area you want to clip.

Drag over the
area you want
to clip

FIGURE 15.15

The screenshot is immediately added to your document.
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I’ll bet you’re starting to see the   future potential of this tool, right? Like any other 
graphic element you add to Word, the Format tab opens with your selected 
screenshot or clip, and you can apply picture attributes to the image. We’ll cover 
more on those in Chapter 16. You can also move and resize any screenshot or 
clipping in your document, treating it just like any other graphic element.

TIP Here’s something interesting—you can save an inserted 
screenshot or clipping as a new picture file to reuse again. Right-
click over the image and choose Save as Picture. This opens the 
File Save dialog box and you can give the file a unique name 
and store it where you like. You can also specify a particular file 
format for the picture using the Save as type   drop-down menu.

Embedding Videos
Adding dynamic content to your documents is easier than ever, and by dynamic, 
I mean video clips. You can watch the clips without having to exit the Word 
document. This means   other people who open the document file can watch 
the clip as well. Let’s use that example about the iguana report again—say 
you want to include a video clip of the newly discovered lizard to show your 
readers what it looks like climbing a rock. You can insert the clip and treat it as a 
graphic element, which means you can move it, resize it, and apply some stylistic 
attributes (such as a border). The clip automatically displays a Play button that 
you, or another user, can click to play the clip.

Inserting a video embeds within the document. This means its information is 
included as part of the file when you save the document. Prior to this new feature, 
you could only insert links to videos. Of course, you can still insert links to videos 
stored elsewhere, but it’s just a link and not an actual embedded clip.

You can insert video from the following sources:

 • Bing Video Search Use this option to search for videos on the Web using 
Microsoft’s Bing  search engine.

 • From a Video Embed Code Use this option if you know the specific embed 
code for the clip from its website.

 • YouTube Use this option to look for clips  on the YouTube site. This option 
isn’t set up by default; you’ll have to click the YouTube icon at the bottom of 
the window to include   the service in your video options list.
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To insert a video from an online source, follow these steps:

 1. Click the Insert tab.

 2. Click Online Video to open the Insert Video tool (see Figure 15.16).

FIGURE 15.16

Start by choosing a source and typing in a keyword or words.

 3. Click in the Bing Video Search field and type in a keyword or words for the 
type of video you’re looking for.

 4. Press Enter or click the Search icon.

 5. A search results page lists any matches, similar to what’s shown in Figure 15.17. 
Use the scrollbar to look through the thumbnails.

 6. When you find one you want, click it.

 7. To download   and embed the video, click Insert.
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FIGURE 15.17

Look through the search results to find the video you want to use.

When the download is complete, Word inserts the video clip as a picture in your 
document, much like Figure 15.18, and displays the Format tab for working 
with the image. As always, you can resize and reposition the clip image area, if 
needed, or   control the flow of text around the clip box.

Click the clip you want to add

Click here when you’re
ready to download

FIGURE 15.18

Word downloads the clip and inserts it for you.
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To play the clip, click the giant Play button in the center of the clip (see Figure 
15.18). Another window opens, as shown in Figure 15.19, along with additional 
playback controls. Click the Play button again to start the clip. You can click the 
Pause button to pause the playback, or click the Volume button to adjust the 
sound. To   exit the clip, click anywhere outside the window.

Volume controlPause button

FIGURE 15.19

An embedded clip plays in its own special window.

To remove a clip you no   longer want, select it and press Delete.
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THE ABSOLUTE MINIMUM
Now you know enough about illustrating your documents with pictures and video 
clips to make your head spin. We covered a lot of information in this chapter, but 
it boils down to this:

 • You can use your online connection to tap into a vast library of pictures on the 
Office.com site, including clip art and stock photos. To get things rolling, click 
the Online Pictures tool on the Insert tab.

 • You can also use the Online Pictures tool to search for pictures on the Internet.

 • Wait, there’s more—you can also use the Online Pictures tool to download 
pictures from your SkyDrive account.

 • You can insert pictures from any of your storage devices, including your hard 
drive, flash drive, memory card, or CD/DVD. Just click the Pictures button 
and locate the file.

 • You can use the Screenshot tool to capture open program windows or take 
clippings from a screen.

 • You can now embed video clips directly in your document and play them back 
without leaving Word.
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Word, 12

images
inserting from Internet, 

240-242
thumbnails, 241

indenting text, 110-111
custom indents, 111
setting indents with the ruler, 

112-115
simple indents, 111
special indents, 112

indexes, creating, 302-305

Insert, 83

Insert Address Block dialog 
box, 354

Insert Cells dialog box, 179

Insert Chart dialog box, 206

Insert command, 178

Insert Greeting Line dialog 
box, 355

Insert Pictures dialog box, 201

Insert Pictures feature, 241

Insert tab, 20
Ribbon, 23

inserting
bookmarks, 307-310
breaks, 139-142
charts, 205, 209

comments, 317-319
cross-references 301-302
drop caps, 152-153
footnotes/endnotes 297-298
images from Internet, 

240-242
pages, 139
pictures

from Bing Image Search, 
244-246

from Office.com, 242-244
from SkyDrive, 246-248
your own, 248-249

Quick Parts, 89-91
Quick Tables, 165-166
sections, 139-142
shapes, 219
SmartArt, 196-197
symbols, 92-93
tables, 162-165

Excel spreadsheets, 
169-170

text box objects, 231-234
WordArt objects, 226-230

insertion points, 82

Internet, inserting images from, 
240-242

italics, applying, 96-98

J-K
JPEG (Joint Photographics 

Expert Group), 238-239

key drives, 250

L
Label Options dialog box, 348

labels, printing, 346-349

layering graphics objects, 
270-274

Layout dialog box, sizing 
graphics, 262

Layout Options icon, 205
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Layout tab, Text Direction 
button, 185

layouts, changing (SmartArt), 
202-203

leader characters, 115

leading, 121

legends, charts, 208

line spacing, 121-123

lists, 118-120

Live Preview feature, 145

lossless compression, 239

lossy compression, 239

M
Mail Merge pane, 350

Mail Merge tool, 349-358

Mail Merge Wizard, 349

Mailings tab, Ribbon, 23

managing
print settings, 336-341
SkyDrive

accessing from Word, 
WEB: 397-398

from your browser, 
WEB: 394-397

margins, 128-130
cells, 184-185

Mark as Final, 68

markup display, changing, 
WEB: 365-367

master Document tool, 296

merge fields, 349

Merge to New Document 
dialog box, 357

merging cells, 181-184

metadata, 330

Microsoft, clouds, 38

Microsoft accounts, 39
adding, 41-42
customizing, 42

account pictures, 43-45
background and theme, 

46-47
services, adding, 47-50
signing in, 39-41
switching between, 41-42

Microsoft Word. See Word

mini toolbar, 26
applying bold, italics, and 

underline, 97
cutting, copying and pasting 

text, 87

Mini Translator, 328

moving
data between files, 66-67
text, 85

Multi-Tool Word for Xenix and 
MS-DOS, 6

N
navigating long documents with 

Navigation pane, 310-313

Navigation pane, 310-313

New Address List window, 352

new features, 8-9

numbered lists, 118-120

O
objects

grouping, 275-276
layering, 271-274

Office 365, 37

Office.com, 241
inserting pictures from, 

242-244

Office Store, 50

Office Web Apps, 
WEB: 398-400

Open dialog box, 64

Open page, 64

opening documents, 62-65

outline, 219

Outline mode, 29

Outline view, 292-296

Overtype, 83

P
page borders, adding, 158

PageDown, 83

page formatting
columns, 130-132
headers/footers, adding, 

134-137
inserting pages, breaks and 

sections, 139-142
margins, 128-130
page numbers, 138-139
vertical alignment, changing, 

132-133

Page Layout tab, 342
Ribbon, 23

page numbers, adding, 
138-139

Page Numbers feature, 138

page orientation, printing, 339

page setup, controlling, 
342-343

Page Setup dialog box, 
129, 343

pages, inserting, 139

PageUp, 83

paint format, 239

panes
Clipboard pane, 87-88
Format pane, effects, 281
Format Picture pane, 286
Format Shape pane, 

224, 229
Grammar pane, 324
Mail Merge pane, 350
Research pane, 328
Revisions pane, 317-319
Spelling and Grammar 

pane, 322
Spelling pane, 323
Styles pane, 150
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Paragraph dialog box, 109

paragraph formatting, 107
alignment, controlling, 108
bulleted lists, 118-120
numbered lists, 118-120
spacing, 120-121

character spacing, 125
line spacing, 121-123
paragraph spacing, 

123-125
tabs, 115-117
text, indenting, 110-115

Paragraph icon, 23

paragraph spacing, 120, 
123-125

pasting
data, 66-67
text, 86

mini toolbar, 87

PDF (Portable Document 
Format), editing files, 
WEB: 375

Picture Border tools, 278

Picture Effects, 279

picture styles, adding, 276-278

Picture Styles gallery, Format 
tab, 277

Picture Styles tool, 278

pictures
adjusting, 285
Artistic Effects, applying, 

281-282
borders, adding, 276-278
colors, tweaking, 286-287
correcting problems, 

285-286
cropping, 282-285
customizing Microsoft 

accounts, 43-45
digital pictures, 237
file types, 238-240
inserting

from Bing Image Search, 
244-246

from Office.com, 242-244

from SkyDrive, 246-248
your own, 248-249

picture styles, adding, 
276-278

removing backgrounds, 
287-289

placeholders, SmartArt, 197

plot area, 208

PNG (Portable Network 
Graphics), 239

point size, changing, 100-102

positioning graphics, 267

previewing documents, 334-335

Print Layout mode, 29

print settings, managing, 
336-341

Print to File command, 337

Print window, 334

printing
collated, 338
documents, 334

managing print settings, 
336-341

envelopes, 343-346
labels, 346-349
page orientation, 339

program window, overview, 
11-14

program window controls, 13

program windows, sizing, 13

prompt boxes, 29

proofreading, 315
AutoCorrect, 324-326
checking spelling and 

grammar, 322-324
highlighting text, 316-317
inserting comments, 317-319
researching and translating 

words, 328-330
text, finding and replacing, 

319-322
Thesaurus, 327-328

protecting documents, 67-68

pushpin icon, 24

Q
Quick Access toolbar, 12, 25

Quick Parts, 135
creating, 91
inserting, 89-91
text, adding, 88-89

Quick Print command, 334

Quick Tables, inserting, 165-166

R
raster, 239

RAW file types, 239

Read mode, 29, 32

red wavy lines, 83

References tab, Ribbon, 23

Remove Background tool, 287

removing
breaks, 142
cross-references, 302
video, 257

Replace All, 320

repositioning
shapes, 222-223
tables, 186-187

requirements for Word, 7

researching words, 328-330

Research pane, 328

resizing
shapes, 222-223
tables, 186-187

by dragging, 173-174
Table Properties dialog 

box, 175-176
Table Tools, 174-175

Restrict Access, 68

Restrict Editing, 68

restricting access to 
documents, 68

Review tab, Ribbon, 23
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reviewing
changes to documents, 

WEB: 371-373
documents, WEB: 362-363

Revisions pane, 317-319

Ribbon, 13, 20
Add-Ins tab, 24
check boxes, 23
Design tab, 23
elements of, 21-23
File tab, 23
galleries, 22
hiding, 24
Home tab, 20, 23
Insert tab, 23
Mailings tab, 23
Page Layout tab, 23
Quick Access toolbar, 25
References tab, 23
Review tab, 23
spinner arrows, 22
View tab, 24

rotating graphics, 267-270

rows
adding, 176-179
deleting, 176-179

ruler, setting indents, 112-115

S
Save As command, 58

Save As dialog box, 59

Save as type drop-down list, 61

saving
documents, 58-60

as web pages, 
WEB: 386-388

file types, 60-61
options, 62

templates, 78-79

screen clipping, 252

screenshots, capturing, 250-254

Screenshot tool, 250

scroll bars, 13

sections, inserting, 139-142

selecting
table parts, 172-173
text, 84-85

selection handles, 75
sizing graphics, 261

Send a Link, WEB: 382

Send as Attachment, WEB: 382

Send as Internet Fax, WEB: 382

Send as PDF, WEB: 382

Send as XPS, WEB: 382

sending documents as 
attachments, WEB: 383

services, adding to Microsoft 
accounts, 47-50

shading, 156
adding, 159

Shape Effects, 279

Shape Styles gallery, 278

shapes
drawing, 218-221
formatting, 223-226
inserting, 219
repositioning, 222-223
resizing, 222-223

Shapes tool, 218

Share screen, WEB: 383

sharing documents, 
WEB: 375-378

Show Markup menu, WEB: 366

signing into Microsoft accounts, 
39-41

simple indents, 111

sizing
graphics, 260-263

alignment guides, 264
selection handles, 261

program windows, 13
shapes, 222-223
tables, 173, 186-187

by dragging, 173-174
Table Properties dialog 

box, 175-176
Table Tools, 174-175

SkyDrive, 241, WEB: 393-394
inserting pictures from, 

246-248
managing

accessing from Word, 
WEB: 397-398

from your browser, 
WEB: 394-397

sharing documents, 
WEB: 375-378

SmartArt, 194-196
changing layouts, colors, 

and styles, 202-203
customizing, 197-201
formatting, 203-205
inserting, 196-197

spacing, 120-121
character spacing, 125
line spacing, 121-123
paragraph spacing, 123-125

special characters, 93

special effects, 152
adding watermarks, 154-156
applying text effects, 

153-154
inserting drop caps, 152-153

special indents, 112

spell checker tool, 83

Spelling and Grammar checker, 
322-324

Spelling and Grammar 
pane, 322

Spelling pane, 323

Spinner arrows, Ribbon, 22

splitting cells, 181-184

starting
documents, 56-57
Word, 9-11

Start screen, 10
turning off, 11

status bar, 13

stick drives, 250

stock photography, 240

strikethrough, 98
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structuring documents with 
Outline view, 292-296

style sets, choosing, 149

styles
applying, 146-149
assigning, 150
changing SmartArt, 202-203
choosing style sets, 149
creating new, 151

Styles gallery, Home tab, 149

Styles pane, 150

subscript, 98

superscript, 98

switching Microsoft accounts, 
41-42

symbols, inserting, 92-93

T
table of contents, creating, 

306-307

table parts, selecting, 172-173

Table Properties dialog 
box, 186

resizing tables, 175-176

Table Styles gallery, 188-191

Table Tools, 171
resizing tables, 174-175

tables, 161
borders, 188-191
cells

adding/deleting, 180-181
alignment/margins, 

184-185
merging and splitting, 

181-184
columns, adding/deleting, 

176-179
custom tables, drawing, 

167-169
Excel spreadsheets, 

inserting, 169-170
inserting, 162-165
Quick Tables, inserting, 

165-166

repositioning, 186-187
rows, adding/deleting, 

176-179
sizing, 173, 186-187

by dragging, 173-174
Table Properties dialog 

box, 175-176
Table Tools, 174-175

Table Styles gallery, 188-191

tabs, setting, 115-117

templates, 72
applying, 72-75
finding, 76-78
saving, 78-79

text
adding with Quick Parts, 

88-89
adding color to, 103-104
Clipboard pane, 87-88
copying, 85
copying and pasting, 86

mini toolbar, 87
cutting and pasting, 86

mini toolbar, 87
deselecting, 85
editing, 82-83
finding and replacing, 

319-322
highlighting with highlighter 

pen, 316-317
indenting, 110-111

custom indents, 111
setting indents with the 

ruler, 112-115
simple indents, 111
special indents, 112

moving, 85
selecting, 84-85
typing, 82-83

text borders, adding, 157

text boxes, 234

text box objects, inserting, 
231-234

Text Box tool, 231

Text Direction button, 185

text effects, applying, 153-154

Text Effects, 279

Text Effects palette, Transform 
category, 230

text formatting, 95
adding color to text, 103-104
applying bold, italics, and 

underline, 96-98
changing point size, 100-102
changing fonts, 98-100
copying from one place to 

another, 104-105
Font dialog box, 102

Text Highlighter tool, 104

text wrapping, graphics, 
264-267

Text Wrapping tab, Layout 
dialog box, 266

themes
applying, 144-146
customizing Microsoft 

accounts, 46-47
Thesaurus, 327-328
thumb drives, 250
thumbnails, 241
tick marks, 208
.TIFF, 238-239
title bar, 12
toolbars, 26-27

mini toolbars, 26
Quick Access toolbar, 12, 25

tools
Borders tool, 157
Eraser tool, 180
Font Color tool, 104
Format Painter tool, 104
Mail Merge tool, 349-358
Picture Border tools, 278
Picture Styles tool, 278
Remove Background 

tool, 287
Screenshot tool, 250
Shapes tool, 218
Text Box tool, 231
Text Highlighter tool, 104
Track Changes, WEB: 362
Watermark tool, 155
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Track Changes, WEB: 362
turning on, WEB: 363-364

Track Changes Options dialog 
box, WEB: 369

tracking, 125
documents, WEB: 362-364

changing markup display, 
WEB: 365-367

comments, WEB: 369-371
reviewing changes, 

WEB: 371-372
turning on tracking, 

WEB: 363-364

Tracking Options icon, 
WEB: 364

Transform category, Text Effects 
palette, 230

Translate Document, 328

Translate Selected Text, 328

translating words, 328-330

turning documents into web 
pages, WEB: 386-388

turning off Start screen, 11

turning on tracking, 
WEB: 363-364

types of charts, 206

typing text, 82-83

U-V
underline, applying, 96-98

vertical alignment, changing, 
132-133

video
embedding, 254-257
removing, 257

view modes, 29
changing, 29-31

View tab, Ribbon, 24

viewing documents, multiple, 
65-66

views
Outline view, 292-296
zooming, 32-33

W
watermarks, adding, 154-156

Watermark tool, 155

Web Apps, WEB: 398-400

Web Layout mode, 29-31

web pages, turning documents 
into, WEB: 386-388

web servers, 36

Windows 7, starting Word, 9

Windows 8, starting Word, 10

Windows Live SkyDrive, 
WEB: 394

wizards, Mail Merge Wizard, 349

Word, 5
closing, 16-17
exiting, 16-17
new features, 8-9
overview, 6-7
requirements for, 7
starting, 9-11

WordArt objects, inserting, 
226-230

Word icon, 12

X-Z
YouTube, 254

Zoom dialog box, 33

Zoom slider, 32, 133

zooming views, 32-33
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